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Chapter 1

Welcome
This program produces SA800 Returns for partnerships. It can either be used alone or in
conjunction with Business Tax.

When usedwith Business Tax, the figures for the SA800 are collected and calculated in Business Tax
before being transferred to Partnership Tax to complete the return.

If used alone, Partnership Tax works as a form filler and you need to enter most of the information
manually.

In either situation, once the figures have been entered on the SA800, Partnership Tax can validate
the return to make sure it is suitable for submission. Submission can be via paper or Internet.

With the SA800 complete, the individual partner's details can be transferred to Personal Tax to aid
the completion of the SA100 Personal Tax Return.

Finding your way around
The Tax Return Viewer is your centre for managing Tax Returns and the submission process.

Note: The viewer will appear slightly different for years 2007 and earlier.

Menu
You can access all the functions of the Tax Return Viewer from the menu. Many of the options will
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also be available in the Tasks pane.

Toolbar
The most popular functions are available on the Toolbar. You'll findmany of these options repeated
in the Menu or the Tasks pane.

Tasks
The most common tasks you're likely to use are available in the Tasks pane. Click on a task to start
each process.

Note: The actual tasks available to you are dependent on your access rights in Sage Taxation. If
you click on a task and see amessage about increasing your access rights, speak to your
administrator.

Forms
The Forms pane is an easy method of moving through the Tax Return. Click on a page to jump
straight to that page.
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PDF Attachments
This pane will list all the PDF files that you have attached to this return.

Tax Return
The page of the Return being viewed is displayed in the large preview area. Use the scrollbars to
move through the page being displayed.

Sage Partnership Tax - Workflow

Producing a Tax Return
The process of completing a Tax Return using Partnership Tax includes the following steps:

1. Create a client

Partnership Tax deals with Sage Taxation clients of type partnership. Partnership clients can be
created directly in Partnership Tax, in Control Centre or in Sage Practice Solution. All required
details, such as name, address, tax district, UTR and lists of partners can be entered using the
Add New Partnership wizard. Later, details can be reviewed and changed using the Main Details
form.

2. Create a tax year

When you first create a client you must specify the tax year that you want to work on for them.
You can subsequently set upmultiple years for the client by performing a year update. You can
produce a tax return for any year that you create and also easily swap between them in the Tax
Return Previewer.

3. Enter tax data onto the tax return

Tax data is typed directly onto the tax return on-screen using the Tax Return Previewer. The Tax
Return Navigator allows you to swap between pages in the return, add extra pages and remove
unnecessary ones. If you wish, you can create multiple sets of tax figures for the year and use
the Tax Return Navigator to choose which set to display on the return in the Tax Return
Previewer.

4. Print the tax return

You can print as many copies of the tax return for yourself and your client before printing a final
copy.

5. File the tax return

The final stage is to mark a set of the client's tax return figures as filed. This is a useful indicator
for yourself and other users, since it informs you that work on the client's return for that tax
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year is complete. You should only do this when the return has actually been submitted to HM
Revenue & Customs.
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Chapter 2

Creating clients
There are three ways to create a client that can be used in Partnership Tax:

l Creating a partnership in Partnership Tax will automatically create that partnership in Sage
Practice Solution (together with any partners as relationships).

If you use Sage Practice Solution and have client integration enabled, clients created in any
Sage Taxation program will automatically be available in Sage Practice Solution. For more
information see Connecting with Sage Practice Solution on page 6.

l Using Control Centre, you can set up clients for any program in Sage Taxation.

l Creating clients in Sage Practice Solution gives you the benefit that your details will be
available to all of the subscribed service programs for the client. If you use Sage Time and
Fees, this will also allow you to create jobs and record time against your clients.

To add a client:

Note: If you use Sage Practice Solution and have client integration enabled, clients created in Sage
Taxation will automatically be available in Sage Practice Solution. For more information see
Connecting with Sage Practice Solution on page 6.

1. From the File menu, choose New. The New PartnershipWizard appears.

Note: If you have more than one dataset, you will need to specify which dataset to add the
client to.

2. Click Next.

3. Enter the Trading name, Correspondence name, and Report name. Click Next.

4. Enter the contact and tax details then click Next.

5. Add partners to the partnership. You can either add existing clients to the partnership or add
new ones.

6. Click Next.

7. Provide a client code. Partnership Tax will suggest one but you may want to tie this into an
existing scheme in your practice. Fill in the rest of the page then click Next.

8. Select the first year you will be entering tax data. Click Next.

9. Select which staff members to assign to the client. Click on the magnifying glass button to
see a look upwindow. Click Next.

10. Choose whether to password protect the client andwhether to include in reports. Click Next
then Finish to create the client.

For more detailed information about each page of the wizard, click Help on the wizard as you create
the client.
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Connecting your Sage programs
With Practice Solution you can share your client data between Sage products for practice.

Connected programs:

l Sage Accounts Production

l Sage Accounts Production
Advanced

l Sage Corporation Tax
(powered by Abacus)

l Sage Taxation

When you install Practice Solution, or any of the products listed above, the connections will not be
enabled. This is to make sure that you are comfortable with your new software before you begin
sharing your client data.

Note: Sage 50 Accounts is used by Practice Solution for billing. This integration is available in
Practice Solution after the billing system has been configured in Sage Practice Solution Control
Panel.

Connecting with Sage Practice Solution
Sage Practice Solution allows you tomanage your clients’ details, link to other Sage products for
practice, record time against work carried out for them and create invoices based on that time.

The software comprises two elements:
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n Practice Hub

n Time recording and invoicing

Your licence agreement with Sage will determine which elements are available.

Sage Practice Hub is the central store for your client data. You can use Sage Practice Hub to connect
your Sage Programs, for tasks, communications, reporting, letter writing etc.

We refer to Sage Practice Hubwith Time recording and invoicing as Sage Practice Solution.

More information
For more information about connecting your Sage programs with Sage Practice Solution, start Sage
Practice Solution (v1.5 or above) and from the Helpmenu choose Contents. When the Help system
appears, use the table of contents to find the book Connecting your Sage Programs.
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Entering data into Partnership Tax
There are two ways to enter data for a client in Partnership Tax:

n You can transfer data from Business Tax. This will save you time retyping information.

n You can edit the return to enter data directly.

Transferring data from Business Tax
Business Tax transfers client data to other programs within Sage Taxation to generate tax returns.

Personal Tax will handle your sole traders’ details and Partnership Tax will produce the SA800
Return for a partnership, before sending individual partner’s details to Personal Tax for their SA100
Personal Tax Returns.

To transfer data from Business Tax:

1. Make sure the client is closed in Partnership Tax.

2. Open the client in Business Tax.

3. Make sure you are viewing the correct year.

4. Click the SA800 button on the toolbar. Partnership Tax will open with the client's data
entered on the SA800 return.

For more information see the Business Tax help .

Editing Returns
You can edit the figures directly in the Tax Return Viewer.

You cannot edit a return once you have started the submission process. 

To edit a return:

1. Preview the copy of a return or final return.

2. Browse to the page of the return containing the information that you want to edit.

3. Click in the box that you want to edit.

4. Enter the new value for the box and press Enter on your keyboard.
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Additional advice on editing returns
Change the main details information that appears on the Return
Information is entered automatically into certain boxes, based on data that you have entered in the
client's Main Details form. You won't be able to click on the Return to change this information.
Instead, open the client's main details by clicking the Details button on the toolbar.

To enter figures or text into a box:

1. Click the box so that the cursor appears.

2. Type in the text or figures that you want to appear in the box.

Ticking boxes 
Some sections of the Tax Return require you to tick a box to indicate which of several options
applies to the client.

Click a box to tick it or clear an existing tick.

Tabbing between boxes
Tomove the cursor to the next box on the Tax Return, press the Tab key. Tomove the cursor to the
previous box on the Tax Return, press Shift+Tab

Automatically calculate figures on the return
Some boxes on the return are calculated automatically based on the values of other boxes.
Partnership Tax will by default automatically calculate these boxes. You can however, override the
autocalculation and enter a figure manually.

Turn off autocalculation
Boxes with a yellow highlight have autocalculation turned on.

9



Chapter 3 

1. Click in a box with autocalc turned on. Amessage appears asking if you'd like to enter a
figure manually.

2. Click Yes.

3. Enter your new figure.

Turn on autocalculation
Boxes with a red highlight have had autocalc disabled.

1. Right-click a box with autocalc disabled.

2. Choose Autocalculation. A confirmation message appears.

3. If you're happy to lose any figure you've entered in the box, click Yes.

4. Autocalculation will be enabled for that box.
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Chapter 4

Managing tax returns
As well as navigating through the tax return, you can also use the navigator to manage the pages in
a client's tax return. 

You can delete pages that aren't needed from the client's return. Pages that are required by HM
Revenue & Customs cannot be deleted.

You can copy any page in the return for which you may need to complete additional copies for a
client. This occurs when there is not sufficient space to enter all the client's details. You can also add
pages to the client's return by selecting one from a list of those available.

Add a schedule to the return
 To add a schedule with the pop-upmenu:

1. Right-click the navigator.

2. From the pop-upmenu choose Add Schedule then the schedule to add.

To add a schedule with the main menu

1. From the Return menu, choose Add Schedule.

2. Choose the schedule to add from the sub-menu.

Note: If the Add Schedule option is greyed out, it may be because you have imported the figures
from Business Tax. In this case, you must first copy the figures before you can add additional
schedules.

Delete a schedule
1. Right-click the navigator.
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2. From the pop-upmenu, choose Delete Schedule, then the name of the schedule you want
to delete.

Finding and correcting errors with the return
Partnership Tax can validate the client's tax return to check for errors andmissing information.
These validations are performed according to rules set down by HM Revenue & Customs. 

Once the return has been validated, any errors will be displayed on a Validations tab. You can click on
an error to jump directly to the problem area on the tax return and correct it.

Some of your clients' returns may be affected by HMRC Special Cases and Exclusions and this will
affect them being filed online. See Special Cases and Exclusions in the help for more information.

You can also print out a list of errors for easy reference.

To find errors within the return:
1. Preview the return you want to check for validation errors.

2. From the Tasks pane choose Validate Return. The return is checked for validation errors.

3. If any validation errors are found, a list is displayed beneath the tax return preview.

To correct errors within the return:
1. When errors are displayed in the Validations tab, double-click on an error to go to the

problem box on the tax return.

2. Click in the box to edit the figures to correct the error.

3. When all errors have been corrected, validate the return again by choosing Validate Return
from the Tasks pane.

To print errors within the return:
1. When errors are displayed in the Validations tab, right-click and choose Print Validation

Errors. A Print window appears.

2. Choose your printer settings and click Print.

Attachments
From November 2006 the HMRCOnline Service for Self Assessment will accept PDF files as
attachments to Self Assessment Returns submitted online.

You can add PDF attachments for Self Assessment returns for 2007 and later to FBI and paper
returns using the Attachments window. To open the Attachments window, click Add Attachment in
the PDF Attachments pane.

There may be HMRC Special Cases that require attachments to be sent with the return. See Special
Cases and Exclusions in the help for more information.
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To add a file
1. Click Add. The Open window appears. (The default location for this window to open to will be

the default PDF location as set in Control Centre).

2. Choose a file and click Open. The file appears in the list.

3. Repeat to add further PDF files.

Note: You can only add PDF files. You can add any number of PDF files, but HMRCOnline can only
accept 20 files. The total size of the selected PDF files cannot exceed 5MB (The size of the files
selected will increase slightly when they are added as they will be encoded for security). Encrypted
or Password Protected PDF files will not be accepted by HMRCOnline.

To remove a file
1. Highlight the file you want to remove in the list.

2. Click Remove. A warningmessage appears.

3. Click Yes. The file is removed.

To view a file
1. Select the file you want to view in the list.

2. Click View. The file is opened in a PDF viewer window.

3. When you have successfully created your final return and it has a status of 'Awaiting
Approval', 'Ready to Submit' or 'Submitted', the attachments will be View only.

A list of the files added to an online submission will be included in the Additional Information box of
the SA800.

Finalise Return
Prior to submitting a return you mark a set of figures as final. This makes the return read only so will
prevent you making any further changes to it. If you find that changes are needed, you can click
Copy return for amendment from the Tasks pane and discard this set.

1. From the Return menu choose Finalise Return. The tax return is validated.

Note: If validation errors are found, you will be warned but will still have the option to finalise
the return.

2. The Finalise Return window appears.

3. Enter a name for the final return or leave the suggested one.

4. Click OK.

5. The return will be marked as final and opens in the preview.
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File a return online

Before you begin

n Your practice must be registered for FBI with HMRC.

n Make sure you've entered your HMRC User ID and password. From the Return menu,
choose Online Filing > Online Filing Credentials .

To file online:

Send the return to the client:
1. Open the copy of a return or final return.

2. In the Tasks pane click Start submission process. The Submission Wizard appears.

3. Choose File Online.

Note: If the return has failed validations, File on Paper will be the only option available.

4. Click Next. The Send Return to Client page appears.

5. If you haven't already sent the return to the client for them to sign, you can either print the
return or save as PDF and send to them via email for them to review.

6. Enter the date you sent the return to the client.

7. Click Next.

Note: At this stage, you will have sent the return to the client andwill be waiting for them to
review and sign the return. Personal Tax expects you to close this wizard and continue with
it when you receive approval from your client.

8. Click Close.

When the client approval has been received:
1. Open the copy of a Return or Final Return.

2. Click Continue submission process. The Submission wizard appears.

Tip: Make sure you're on the Client Approval page.

3. Select Yes and enter the date of acceptance.

4. Click Next. The Ready to File page appears.

5. Click Close.

6. Choose Return > Online Filing > File Return. The Online Filing window appears. 

7. If there are returns available to file from more than one year you'll be able to select and
process the earlier years before moving on to the later years.
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8. Select the return to file then click the arrow button tomove the return to the Returns to file
list.

9. Click File. Progress bars appear showing the submission status.

File a return by paper
If you choose to file by Paper, you (or your client) will print out a copy of the return for filing. 

When using this method, it's not necessary for the return to pass all validations. Personal Tax will
allow you tomark the return as Filed even though it failed some of the validation rules. We
recommend that you ensure the return has passed validation prior to filing.

Send the return to the client:
1. Open the copy of a return or final return.

2. In the Tasks pane click Start submission process. The Submission Wizard appears.

3. Choose File on Paper.

Note: If the return has failed validations, File on Paper will be the only option available.

4. Click Next. The Send Return to Client page appears.

5. If you haven't already sent the return to the client for them to sign, you can either print the
return or save as PDF and send to them via email for them to print out.

6. Enter the date you sent the return to the client.
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7. Click Next.

Note: At this stage, you will have sent the return to the client andwill be waiting for them to
review and sign the return. Personal Tax expects you to close this wizard and continue with
it when you receive approval from your client.

8. Click Close.

When the client approval has been received:
1. Open the copy of a Return or Final Return.

2. Click Continue submission process. The Submission wizard appears.

Tip: Make sure you're on the Client Approval page.

3. Select Yes and enter the date of acceptance.

4. Click Next. The Submit Return to HMRC page appears.

5. Enter the date you submitted the Return.

6. Click Next.

Note: At this stage, you will have submitted the Return to HMRC andwill be waiting for a
submission response. Partnership Tax expects you to close this wizard and continue with it
when you receive a response from HMRC.

7. Click Close.

When a response has been received by HMRC:
1. Open the copy of a Return or Final Return.

2. Click Continue submission process. The Submission wizard appears.

Tip: Make sure you're on the HMRC Response page.

3. Enter the date of the response.

4. Click Next. The status of the Return changes to submitted.

5. Click Close.
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Transferring partners' profit details to Personal
Tax
The Profit Splitter allows you to transfer details of each partner's share of the profits to their SA100
Personal Tax Return in Personal Tax.

To successfully transfer partner's profit details to Personal Tax:

n The partner must be an individual client and set up for Personal Tax

n Indicate how much profit each partner received. See Apportioning profits between partners
on page 17.

To transfer details of the Partner's share of the profits to Personal Tax:

1. Complete the Partnership Tax Return including details of the partnership's income.

Note: If you make any changes to the figures on the Partnership Tax Return prior to
transferring the partner's income details, the partner's personal Tax Return will not be
updated automatically. You will have to transfer the figures again once the changes have
been made.

2. Details of profits are transferred for the currently selected Tax Year only. All partners must be
set up for that Tax Year in Personal Tax prior to transferring the figures.

3. From the Tools menu choose Transfer Partners' Data. The Post to Personal Tax window
appears.

4. Your clients available to post to Personal Tax will be listed in the left hand-panes. Partnership
Tax recognises which clients will need to be set up in Personal Tax and lists these in the
bottom left pane.

5. Select the clients to post to Personal Tax and click the right arrow button .

TipYou can move all the clients in one step by clicking the double right arrow button . and
if you select a client to post to Personal Taxation that you didn't intend, you can use the left
arrow buttons to remove them from the post lists. .

6. Click Post to post the clients' details to Personal Tax.

Apportioning profits between partners
The portion of the profits each partner receives is entered into the system as a ratio.

To enter the profit split for each partner:
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1. From the Tools menu choose Profit Sharing Ratios. The Profit Sharing Ratio window
appears. Each partner for the current partnership is listed. 

2. Enter the fixed profit each partner receives in the Prior Allocation column. This is not included
in the apportionment but is deducted from the total profit prior to apportionment.

3. Enter the split each partner receives as a ratio in the last column(s). If a partner's start or end
date for the partnership falls in the current tax year, there will be more than one column, one
for each section of the tax year prior to and following the relevant start or end date. The
partner's ratio will be set to zero for times when the individual was not a partner in the
partnership.

4. If each partner receives an even split, click Split Evenly to enter this information
automatically.

5. To enter the split as a percentage, make sure that the ratios add up to a total of 100.

6. Click Apply PSRs.
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